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Data Transfer Overview

• Uses the System i5 database server to transfer data to and from DB2 
database files and System i5 source physical files

• Provides an SQL-like interface to allow full file SELECT or customized 
queries including joins, sorting, and record grouping

• Capable of transferring data to and from many popular PC file types
• Provides access to System i5 file members
• Transfers may be run interactively, in batch mode, programmatically, or 

directly from Microsoft Excel
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Data Transfer Overview

Data Transfer is limited to transferring source physical files and data physical 
files to PC file types and PC file types to the source and data physical files on the 
System i5.  Transferring other types of files to and from a PC and the System i5 
requires using other methods.  Some other types of files that reside on the 
System i5 are stream files or flat files such as those stored in the Root or 
NetWare portions of the System i5 Integrated File System.  These files may be 
accessed using the methods listed below.

System i5 NetServer through 'shares'
iSeries Navigator Integrated File System (IFS) support
File Transfer Protocol (FTP)
The IBM Toolbox for Java IFS classes
iSeries Access for Web
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Components of a Data Transfer

Supported transfer request file types

• Data Transfer From iSeries
– .DTF - New request type used in iSeries Access
– .TTO - Request type used in XD1 and DOS Extended clients
– .DT - Request type used in Windows 3.1 client
– .RTO - Rumba transfer request file

• Data Transfer To iSeries
– .DTT - New request type used in iSeries Access
– .TFR - Request type used in XD1 and DOS Extended clients
– .DT - Request type used in Windows 3.1 client
– .RTO - Rumba transfer request file
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Upload file to System i5

Library: INFO

Table: CUSTOMER

Basic Data Transfer
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Setting up the library list

Optional:  To aid us 
when we are looking 
for files, we need to 
add the libraries to 

the library list. 

To set properties go 
to the File menu and 

select Properties.

Basic Data Transfer
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Basic Data Transfer

• The wizard creates a:
– File Description File (FDF)
– Database file on the server

• The wizard does not do the actual data transfer to the System i5

What is the iSeries Database File Wizard?
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Basic Data Transfer

Starting the iSeries Database File Wizard

Start the Create 
iSeries Database 

File tool by 
selecting it from the 
Tools menu or by 
clicking on its icon 

in the toolbar
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Basic Data Transfer

Selecting the PC file that contains your data
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Selecting the PC File Type

Basic Data Transfer
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Basic Data Transfer

The File Description File panel
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Basic Data Transfer

The Change Data Format Options panel
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Basic Data Transfer

The Scan PC File panel
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Basic Data Transfer

The Contents of PC File panel
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Basic Data Transfer

The Field Details panel
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Basic Data Transfer

The System Name panel
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The iSeries File and Library panel

Basic Data Transfer
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Basic Data Transfer

The File Description Text panel
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Basic Data Transfer

The Confirm Create Options panel
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Basic Data Transfer

The final panel - your file has been created!
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Basic Data Transfer

The PC file we used as a 
model

The system we created the 
file upon

The Library/File name of 
our new file

Returning to Data Transfer To iSeries

Click to transfer data to 
your new file
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Basic Data Transfer

• Creating the table and FDF does not do the data transfer
• Plan ahead by increasing lengths if necessary 
• Do not include character and numeric data in the same column

Key points about the iSeries Database File Wizard
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Basic Data Transfer

Data Transfer to iSeries:  Specifying iSeries File Details
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Basic Data Transfer

Data Transfer to iSeries: iSeries File Details - upload options

Source Physical files
Select not to use an FDF file
Select the proper file type
Select the record length, file 
and member text and authority 
on create

Data Physical files
Use a PC FDF file
Select Field Reference File, file 
and member text, and authority 
when creating new files
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Running Data Transfer by Clicking an Icon

Saving the request

Clicking File->Save As allows 
you to save the request.
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Running Data Transfer by Clicking an Icon

Auto-run/Auto-close support

Clicking File->Properties allows 
you to customize properties 
related to this data transfer.
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon
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Batch transfer command interface

Running Data Transfer by Clicking an Icon

• RTOPCB
– Does batch data transfers from System i5 to PC

• RFROMPCB
– Does batch data transfers from PC to System i5

• RXFERPCB 
– Does batch data transfers from System i5 to PC
– Does batch data transfers from PC to System i5
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RTOPCB [/S] [[/I] [filename [/C] [...] ] | [[I] /F list file] ]

/S        Show transfer statistics.
filename An iSeries to PC transfer request (.TTO or .DTF),

Rumba (.RTO), or Windows 3.1 (.DT) file transfer
request.

/C          Process next file independent of previous file.
/I          Ignore warnings.
/F     Process files within list file (one filename per line).
list file A file containing a list of transfer files to process.

Examples:
RTOPCB c:\temp\test.tto
RTOPCB /S c:\temp\test.tto /C c:\temp\trans.dtf
RTOPCB /S /F c:\temp\transfer.dtf

Data Transfer from iSeries:  Batch transfer command interface

Running Data Transfer by Clicking an Icon
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Running Data Transfer by Clicking an Icon

Data Transfer to iSeries:  Batch transfer command interface

RFROMPCB [/S]  [[/I]  [filename [/C] [...] ] | [/I] [/F list file] ]

/S     Show transfer statistics.
filename A PC to iSeries file transfer request (.TFR or .DTT),

Rumba (.RTO), or Windows 3.1 (.DT) file transfer request.
/C         Process next file independent of previous

file.
/F         Process files within list file (one filename per line).
list file  A file containing a list of transfer files to process.

Examples:
RFROMPCB c:\temp\test.tfr
RFROMPCB /S c:\temp\test.tfr /C c:\temp\trans.dtt
RFROMPCB /S /F c:\temp\transfer.dtt
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Running Data Transfer by Clicking an Icon

Data Transfer between iSeries:  Batch transfer command interface

RXFERPCB request userID password

request  - Fully qualified file name of any Client Access upload or download
request of type .DTF, .DTT, .TTO, or .TFR.

userID - A valid iSeries user profile for the system specified in the request.
password - A valid password for the specified user profile.

Examples:
RXFERPCB c:\temp\upload.dtf myuserid mypassword
RXFERPCB c:\temp\download.dtt myuserid mypassword
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Running Data Transfer by Clicking an Icon

Shortcut to the Data Transfer command line interface

To create a new shortcut:

Right click on an open area of Windows 
Explorer (or My Computer)
Select New -> Shortcut
Find and select the RXFERPCB, RTOPCB, 
or RFROMPCB program in the Client Access 
Folder
Name the shortcut
Right click on the new shortcut and select 
properties from the menu
Add the full path of the transfer request to run 
after the command
Select to run minimized
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Running Data Transfer by Clicking an Icon

Running by double-clicking the icon

Data is updated.  
No prompts!
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Add a scheduled task

Scheduling Data Transfers

• iSeries Access for Windows 
does not provide a scheduler 
program.  For this example, we 
use Microsoft's Task Scheduler 
application.

• To access Microsoft’s Task 
Scheduler, go to your Control 
Panel, select Scheduled Tasks, 
and select Add Scheduled Task. 
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Add the transfer request to run

Scheduling Data Transfers

• Modify the Run line to include the 
transfer you want to run
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Scheduling Data Transfers

Viewing scheduled tasks
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Data Transfer from iSeries

Library: QIWS

Table: QCUSTCDT

Using the Excel Add-in
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Using the Excel Add-in

• Available with Microsoft Excel 97, Excel 2000, and Excel XP.
• Use this support by:

– Clicking on the Data Transfer upload or download button on the Excel toolbar
– Using the options on the Data menu bar

What is the Excel Add-in?
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Using the Excel Add-In

• Open Microsoft Excel
• Click Add-Ins from the 

Tools menu
• Click the Browse... 

button
• Locate the path in which 

you installed Client 
Access

• Double click on the 
folder named 'Shared'

• Double click on the 
cwbtfxla file

• Click the OK button

Installing the Excel Add-In
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Data Transfer from iSeries: The Transfer Request panel

Using the Excel Add-in
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Using the Excel Add-In

Data Transfer from iSeries:  Creating a new data transfer request
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Using the Excel Add-In

Data Transfer from iSeries: Choose the file to download
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Using the Excel Add-In

Data Transfer from iSeries: Customize the Data Transfer request



26

IBM System i

© 2006 IBM Corporationi want an i.

• Customizing Data Options allows you 
to set options like:
– what fields are retrieved
– the ordering of the data
– only retrieve data based on certain 

conditions

Using the Excel Add-In

Data Transfer from iSeries: Customizing Data Options
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Using the Excel Add-In
Data Transfer from iSeries: Customizing Format Options
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Using the Excel Add-In

• Conversions
– Allows for the enablement of special 

data conversions and for error logging
• Library List
• Display
• SQL
• Connection

– Can configure signon and security 
options

• Startup
– Can enable option to run transfer 

request automatically later

Data Transfer from iSeries: Customizing run-time options
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Using the Excel Add-In

Data Transfer from iSeries: Specify a file name
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Using the Excel Add-In

Data Transfer from iSeries: Viewing the results
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Using the Excel Add-In

• Support for uploading data added in V5R1
• Support allows the following functions for transferring data to the iSeries:

– Create new file and member based on iSeries file
– Create new file and member based on spreadsheet
– Create new member
– Replace member
– Append to existing member

Data Transfer to iSeries: Notes
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Data Transfer to iSeries: Highlighting the data

Using the Excel Add-in
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Using Data Transfer with a Web server

HTML File support - Updating a web server on System i5

Client PC

Data Transfer to
Workstation

HTML File 
Generated

at PC

Client browser 
views HTML on 
System i5 Web 
Server

Send HTML to System i5
Web Server (file system)

1
2

2
3
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Using Data Transfer with a Web server

HTML File support - Updating a web server on another machine

AIX or NT Web 
Server

Client PC

Data Transfer to
Workstation

HTML File 
Generated

at PC

Send HTML to 
Web server 

Client browser 
views HTML on 
Web Server

1

2
2

3
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Running Data Transfer by Clicking an Icon

• Installable option of iSeries Access
• Gives System i5 users ability to start remote commands on a PC
• Message logged in the iSeries Access for Windows History log identifying 

what was run

• CWBRXD
– Name of program that controls Incoming Remote Commands
– Runs as a Windows service called iSeries Access for Windows Remote 

Command. 
• RUNRMTCMD

– System i5 server CL command 
– Used to send PC command requests to the PC running the IRC service.  

Incoming Remote Command (IRC)
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Downloading a file to HTML

Using Data Transfer with a Web server



32

IBM System i

© 2006 IBM Corporationi want an i.

Setting HTML properties

Using Data Transfer with a Web server

• File
• Document

– Specify a title and timestamp
• Table

– Specify spacing, alignment, and other table 
properties

• Caption
– Specify whether to add a caption for your 

table
• Row
• Cell
• Template
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Using Data Transfer with a Web server

HTML Template allows System i5 
tabular data to be inserted into a pre-
formatted HTML document at a 
specified location.  The location is 
defined by an embedded template 
tag.

The template document may contain 
graphics, links, frames, and any other 
HTML elements you provide.

HTML Template support - enhancing web pages
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Using Data Transfer with a Web server

<HTML>
<HEAD>
<TITLE>Sample HTML Code</TITLE>
</HEAD>
<BODY>
<H1>Customer Data</H1>
<!-- TABLE1 -->
</BODY>
</HTML>

Using HTML Template Files

When the transfer is run, the template file will be used as a base for the new HTML file.  
When data is received from the System i5, the data will be formatted and will inserted in 
place of the <!-- TABLE1 --> tag.

IBM System i
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Using Data Transfer with a Web server

DATALINK data type support

Transferring the DB2 UDB for iSeries DATALINK type to a HTML file will produce 
active links within your HTML File.

…………

http://www.common.org/index.html800-270-8223Chicago, ILCOMMON

http://www.ibm.com/eserver/iseries/index.html800-426-3333Rochester, MNIBM iSeries

WEBSITEPHONEADDRESSCUSTNAM
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Viewing the results

Using Data Transfer with a Web server
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Using Data Transfer with a Web server

• Data Transfer may be used as an data utility in e-business processes.
– May be used to upload gathered transactions to the System i5 from a PC 

server acting as the e-business interface.
– May be used by CGI programs on the PC Server to build standard PC files 

which may then be sent to customers through the web.
– May be used to generate HTML files to be published on a web server.
– ActiveX objects (or RXFERPCB) may be used in 3-tier to run data transfer 

from a Windows Web Server.

Movement of data
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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Using the Data Transfer Query Builder

Starting the Data Transfer query builder
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Using the Data Transfer Query Builder

Setting up a query

Enter "SQL-like" 
statements directly 
into the edit panels

OR

Click on Details... to 
bring up the Data 
Transfer query builder
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Using the Data Transfer Query Builder

Select fields to transfer from the iSeries

Double click on field 
names in the field list 

to add them to the 
Select clause.  

Functions such as 
SUM may also be 

used to return 
functional results
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Using the Data Transfer Query Builder

Creating a where clause

Specify conditions on data 
transferred from the System i5 by 

building a where clause.  

Double click on a field name or 
specify a function, then specify a 

test condition by double clicking on 
a test operator.  Enter the right 
side of the comparison in the 

comparison dialog.
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Using the Data Transfer Query Builder

Ordering data

An Order By clause may be 
specified to order data transferred 

from the System i5.

Fields may be ordered in 
ascending or descending order by 

specifying either ASC or DESC 
after each field name.  Currently, 

on the System i5, fields used in the 
order by must also exist in the 

Select clause.
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Using the Data Transfer Query Builder

Multi-file joins

When multiple files are specified 
for download on the main Data 

Transfer panel, a join clause may 
be built to conditionally join 

records across multiple files.
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Using the Data Transfer Query Builder

If Group By functions are enabled on 
the Data Options panel, a Group By 
statement may be specified to group 

records that are returned.

Record grouping
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Using the Data Transfer Query Builder

Conditional record grouping from a 
Group By operation may be done by 

specifying a Having clause.

Conditional grouping using Having
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Using the Data Transfer Query Builder

A Native SQL interface is 
provided for power users or 

for situations where the 
Data Transfer format does 

not provide enough 
functionality

Activating the Native SQL Interface
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Using the Data Transfer Query Builder

After choosing to process 
your statement as Native 
SQL, the Data Options 

button activates a Native 
SQL panel

Finding the Native SQL Interface
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Using the Data Transfer Query Builder

The Native SQL 
interface allows you to 

type in a free form 
SELECT statement.  A 
list of files and columns 

in those files are 
provided to help you 
build your statement

Using the Native SQL Interface
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Data Transfer Usage

• Basic Data Transfer
• Running Data Transfer by Clicking an Icon
• Scheduling Data Transfers
• Using the Excel Add-in
• Using Data Transfer with a Web server
• Using the Data Transfer Query Builder
• Tips and Tricks with Data Transfer
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V5R4 Enhancements

• Support MS Excel XML 
Spreadsheet format

• Supports 128 byte column names
• Supports PC selection of an 

independent auxiliary storage pool 
(IASP)

• Supports creating and overwriting 
empty query result sets
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Tips and Tricks with Data Transfer
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Tips and Tricks with Data Transfer

• Renaming a column – Ex: COL1 AS CUSTOMERS 
• Reordering columns
• CAST’ing a column – Ex:  CAST (COL1 AS INT) )
• Scalar functions 

SQL Tips



43

IBM System i

© 2006 IBM Corporationi want an i.

Tips and Tricks with Data Transfer

• Data Compression
• Indexes
• SQL performance clauses

– OPTIMIZE FOR N ROWS
– FOR FETCH ONLY / FOR UPDATE
– FETCH FIRST N ROWS ONLY

Performance Considerations
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Tips and Tricks with Data Transfer

• Transfers to PC
– Working with CCSID 65535 fields
– Working with date/time/timestamp fields
– Modifying output into PC Files

• Transfers to Server
– V5R3 Data Transfer change to Unicode fields when uploading data

Common Problems
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Summary

• Take advantage of all the ways you can use Data Transfer
– Running requests by clicking an icon
– Scheduling data transfers
– Using the Excel Add-in
– Using with a web server
– Running advanced queries
– Using ActiveX Automation Objects
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iSeries Access for Windows sessions:

32MC - iSeries Access for Windows:  What’s New in V5R4
33MI - iSeries Access Data Transfer: Tips & Techniques
42MK - Performance Tune iSeries Access ODBC
43MC - PC5250 Emulation:  Everything You Need To Know 
46ME - iSeries Access in the .NET World

iSeries Access for Linux session:

53ML – Creating the iSeries Linux Desktop

Stop in EXPO for a demo…

Functional enhancements can be submitted via the FITS system.  The 
url is: 
http://www.ibm.com/eserver/iseries/access/
And click on link “Request for Design Change”
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Session title:
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Appendices

• Components of a Data Transfer Notes
• Scheduling Data Transfers
• Administering Access to Data Transfer
• Data Transfer ActiveX Automation Objects
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Components of a Data Transfer

• Data Transfers involve 4 basic components
– PC File
– An iSeries Database or Source Physical File
– File Description File (FDF)
– New or existing transfer request
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Components of a Data Transfer

• A PC file is a standard "flat file" located on (or to be created on) your 
network or workstation.

• Data Transfer supports many popular PC file formats
– Lotus 1-2-3  (.123) and Lotus 1-2-3 version 4 (.wk4)
– ASCII Text (.txt)
– Basic Random and Basic Sequential
– Microsoft Excel (BIFF) versions 3, 4, 5, 7, and 8 (.xls)
– Comma Separated Variable (.csv)
– Data Interchange Format (.dif)
– DOS Random, including type 2
– Tab Delimited Text (.txt)
– No Conversion (EBCDIC)
– Hypertext Markup Language (.htm, .html)

Component I: The PC File
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Components of a Data Transfer:

Data Transfer supports many popular PC file formats when transferring data to or from the System i5.  
However, some rules apply when performing a data transfer, especially uploading data to the System 
i5.

Download
• The PC file type to download to must be able to hold the data from the System i5 file.  For 

example, downloading to a BIFF3 (Excel version 3) file limits character fields to 256 characters 
and only allows 16,385 rows in a spreadsheet.

Upload
• If uploading to an existing System i5 file, the format of the data in the PC file must match the 

format of the data in the System i5 file.
• If the PC file has column names those names must match the names in the File Description File 

and the System i5 file.
• The HTML file type is not supported for upload.
• Uploading to a database file (table) requires that you have a File Description File (FDF) to match 

your PC file.
Uploading to a source physical file with a file type other than ASCII text will only send the first column 
of data from the PC file.  If more than one column exists in the PC file, you will get a message stating 
that extra data was found at the end of the file and will be truncated.

PC File Types
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Components of a Data Transfer

Transferring data to or from the System i5 requires you to specify either a database table(s) or 
source physical file.  Each of these file types may contain multiple members.

Database File
An System i5 file in the form of a relational table. It has a specific layout composed of various 
types of columns with various lengths.

Source Physical File
An System i5 file normally contains 3 columns.  A SRCSEQ, SRCDAT, and SRCDTA column.  
The first column is a sequence number.  The second column is a date, and the last column 
contains your data.  The first two columns are six bytes each, and the last column may be 
variable length.

Component II: An iSeries Database or Source Physical File
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Components of a Data Transfer

A file description file (FDF) is a PC file used to describe a PC data file.  A file description file is 
required when transferring data to a database file on the System i5.

An example file description file:
PCFDF
PCFT 19
PCFO 1,1,1,1,1
PCFL Name 1 8
PCFL Address 1 13
PCFL Zip 2 6
PCFL Phone 1 8
PCFL Balance 2 8/2

Component III: The File Description File (FDF)
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Components of a Data Transfer

The PC File Description File (FDF) contains various record types.

The first line of an FDF file must contain PCFDF.  This line indicates that the file is an FDF.

The next line of the file, PCFT, indicates the PC file type.  File type 19 signifies an FDF for use with the 
Lotus 123 Version 9 file type.  Values for other file types are as follows:

ASCII Text  =  1 Dos Random = 2 BasicSequential = 3 Basic Random = 4
DIF = 5 No Conversion = 6 Dos Random = 7 Dos Random Type 2 = 8
BIFF 4 = 9 BIFF3 = 10 BIFF5 = 11 CSV = 12
Lotus WK4 = 13 Tab Delimited Text = 14 BIFF7 = 15 BIFF8 = 16
Lotus 123 = 17 Excel Add-in = 18 Lotus 123 Version 9 = 19

The PCFO line indicates PC file options.  These options include date and time formatting and the 
decimal separator to use.

The PCFL lines contain the fields of the PC file.  These are in order, top to bottom, listing fields in the 
PC file.  The first column is the field name, for example, Address, the next column is the data type, and 
the final column is the length.  The most common data types are '1' for character and '2' for numeric.  
The third column may contain two numbers separated by a '/'.  This indicates that the field has numeric 
scale.

File Description File (FDF)
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Components of a Data Transfer

• What is a transfer request?
– A transfer request is a PC file created by and used with Data Transfer for 

storing options and settings for the transferring of data to or from the System 
i5.

• Some of the items stored in a transfer request include:
– System i5 system name
– System i5 file name(s)
– PC file name
– PC File Description File name
– PC file type

Component IV: The Transfer request
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Add a scheduled task

Scheduling Data Transfers

• iSeries Access for Windows 
does not provide a scheduler 
program.  For this example, we 
use Microsoft's Task Scheduler 
application.

• To access Microsoft’s Task 
Scheduler, go to your Control 
Panel, select Scheduled Tasks, 
and select Add Scheduled Task. 
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Choose the application to schedule

Scheduling Data Transfers

• Click Browse
• Choose the RXFERPCB.EXE, 

RTOPCB.EXE or 
RFROMPCB.EXE program 
located by default in:

C:\Program Files\IBM\Client Access
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Choose how often to run the task

Scheduling Data Transfers
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Choose the time to run the task

Scheduling Data Transfers
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Choose the user ID to run the task

Scheduling Data Transfers
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Verify summary information

Scheduling Data Transfers
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Add the transfer request to run

Scheduling Data Transfers

• Modify the Run line to include the 
transfer you want to run
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Scheduling Data Transfers

Viewing scheduled tasks
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Administering Access to Data Transfer

• Some options include:
– Microsoft System Policy support
– Application Administration
– Exit Programs
– Object-level database security
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• Data Transfer From iSeries - Limiting 
downloads
– Prevent usage of Data Transfer From 

iSeries
– Prevent usage of Data Transfer GUI
– Prevent usage of RTOPCB command
– Prevent autostart uploads
– Prevent usage of Excel-Add In

• Limiting users to only autostart 
downloads will help to prevent them from 
modifying transfer requests and keep 
them from downloading any file they have 
read access to on the System i5.

Administering Access to Data Transfer

Microsoft System Policies

IBM System i

© 2006 IBM Corporationi want an i.

• Data Transfer To iSeries - Limiting 
uploads
– Prevent usage of Data Transfer To 

iSeries
– Prevent appending to/replacing host 

files
– Prevent usage of Data Transfer GUI
– Prevent usage of RFROMPCB 

command
– Prevent autostart uploads

• Limiting users to only autostart uploads 
will help to prevent them from modifying 
transfer requests and keep them from 
using Data Transfer in potentially 
harmful ways.

Microsoft System Policies

Administering Access to Data Transfer
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Administering Access to Data Transfer

• Data Transfer To iSeries - iSeries server 
file creation
– Prevent creation of new files on the 

System i5
– Prevent creation of files via the Data 

Transfer
• Create iSeries Database File wizard

– Prevent creation of files via the standard
• "created based on" or Field Reference 

File method.

Microsoft System Policies
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Administering Access to Data Transfer

1. Get the System Policy Editor from http://www.microsoft.com.
2. Open an MS-DOS window. 
3. Go to the iSeries Access for Windows directory, normally located at:  

[C:]\Program Files\IBM\Client Access\
4. Run the cwbadgen /std command in the MS-DOS window.  This 

generates the caerestr.adm policy template needed to create the policy 
file.

Getting a system setup for policies

For more information on policy support see:
http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?topic=/rzaii/rzaiiconfiguration.htm
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Getting a system setup for policies

1. Start the policy editor by double-clicking on poledit.exe. 
2. Go to Options > Policy Template > Add. 
3. Go to the location where you stored the .adm files that you created in creating 

policy templates. 
4. Select the .adm files that you want to add and press Add. Keep doing this until 

you have added all the .adm files you want to use. Click OK. 
5. Select File > New Policy. 
6. Set your policies and save the policy file: 

1. \\QYOURSYS\POLICIES\config.pol (for Windows 95/98) -or-
2. \\QYOURSYS\POLICIES\ntconfig.pol (for Windows NT)

7. Where:
• QYOURSYS is the name of your System i5 NetServer. 
• POLICIES is the name of the shared file folder on your System i5 NetServer. 
• (nt) config.pol is the name of your policies file. 
• To update the policy file, open your policy file with the policy editor, make your changes and 

save the file back to the above location. 
• Note: You must create and maintain policies for the Windows 95/98/Me and Windows 

NT/2000 separately. (Policies created for Windows 95 will not work on an NT system, and 
vice-versa.)

Administering Access to Data Transfer
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Administering Access to Data Transfer

• To get to Application 
Administration:
– Open iSeries Navigator
– Click on the system you 

want to administer
– Go to the File menu 

and select Application 
Administration -> Local 
Settings

iSeries Navigator Application Administration
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Administering Access to Data Transfer

• Application Administration
– Provides similar capabilities as Microsoft PC based policies
– Administration information is stored on the System i5
– Data Transfer options are stored on a per user/per System i5 basis
– Customize user access to Data Transfer functions

iSeries Navigator Application Administration
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Note: Data Transfer and ODBC use the same server for database access.  
Currently, exit programs created for Data Transfer are also active for ODBC 
users.

Administering Access to Data Transfer

• Exit Programs
– Exit programs written for the QIBM_QZDA NDB, ROI, and SQL exit points 

may help to restrict certain users from accessing specific files.
– Configured with WRKREGINF on the System i5
– Given the SQL statement sent from the client application (Data Transfer).  

Statements may be rejected by the user exit program
– May be written in a variety of host languages

iSeries host server exit programs
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Administering Access to Data Transfer

• All objects on the server, including SQL objects, are managed by the 
system security function

Object-level database security

See:
http://publib.boulder.ibm.com/infocenter/iseries/v5r4/index.jsp?topic=/rzahf/rzahfsecurity.htm
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Data Transfer ActiveX Automation Objects

ActiveX Automations are re-usable objects that reside on your
Windows PC.  Many times they can be used to run an application by
"remote" with a program or script.

They work similarly to Object Linking and Embedding (OLE), used
for things like inserting an Excel spreadsheet into a WordPad
document.  Not just cutting and paste, actually "linking" the
spreadsheet into the document.

ActiveX objects work much like this, except in the programming world.

ActiveX?  Automation Objects?  So what's this?  What can they do for me?
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Data Transfer ActiveX Automation Objects

ActiveX automations can be used to quickly and easily perform many tasks 
with little or no user intervention.  For example, a program may use the 
Automations for Microsoft Excel to perform various data calculations 
without ever bringing up the Excel interface.

ActiveX automations can be used to create new custom interfaces
over applications that have ActiveX automations.  A few examples are 
Microsoft Office products, Internet Explorer, the PC5250 emulator, and 
various iSeries Access for Windows functions.

So what can they do for me?
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Data Transfer ActiveX Automation Objects

• ActiveX automations are supported by many programming languages 
including:
– Visual Basic
– Visual Basic for Applications (used by Microsoft Office)
– Visual Basic Script (used in web pages and the PC5250 emulator)
– C++
– Java
– Lotus Script
– Many other applications and development environments

• You must write program code to use these objects.  Or allow some
development tool to write the code for you.

OK, how do I use them?
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What Automations are available for Data Transfer?

Data Transfer ActiveX Automation Objects

• Two types of ActiveX Automations for Data Transfer
– High Level Automations
– Low Level Automations

• Labeled based on functionality and ease of use
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Easier to use, but limited functionality!

With the high level automations you can run a Data Transfer with as little as 2 lines 
of code!

High Level Automations

Data Transfer ActiveX Automation Objects



61

IBM System i

© 2006 IBM Corporationi want an i.

Data Transfer ActiveX Automation Objects

The name of this object is DatabaseTransfer

The DatabaseTransfer object can be used to run a simple upload, download, 
or an existing transfer request file! 

The High Level Automation Object
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Data Transfer ActiveX Automation Objects

These two lines of Visual Basic (VB) code can be used to run a download:

Dim dt As New cwbx.DatabaseTransfer
dt.Download "mysys", "qiws/qcustcdt", "c:\myfile.xls", cwbdtBIFF5

To do an upload:

dt.Upload "mysys", "cwbxtest/qcustcdt", "c:\qcustcdt.txt", "c:\qcustcdt.fdf"

To run a saved request:

dt.Transfer "c:\qcustlst.dtf"

Using the DatabaseTransfer Object
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Data Transfer ActiveX Automation Objects

The DatabaseTransfer automation object also contains properties 
you can query or set for the transfer request.

• Errors - for query only.  A standard collection of error messages.  
Messages get put into this collection while the request is running

• Password - Allows you to set the password for the System i5 
connection necessary for the transfer

• TransferResults - Allow you to get the number of rows transferred, 
return codes, and error and warning locations.

• UserID - Allows you to set the user ID to use for this transfer request.

Using the DatabaseTransfer Object
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The Low Level Automation Objects

Data Transfer ActiveX Automation Objects

• There are two main Low Level Objects:
– DatabaseDownloadRequest 
– DatabaseUploadRequest 

• Various properties must be set on these objects to perform an upload 
or download

• Used with other Client Access Express Automation objects.
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Data Transfer ActiveX Automation Objects

Using the DatabaseDownloadRequest Object

The DatabaseDownloadRequest object can be used to programmatically perform 
a download from the System i5 to a PC workstation.  It contains 5 additional 
objects that may be set to perform a download.  Each of these objects has various 
settings.

DatabaseAS400File - Stores the name of the file or files to download.
DatabaseDownloadPCFile - Stores the name of the PC file to download, plus 
file options.
DatabaseQuerySettings - Query settings for the download.
DatabaseFormatOptions - Data/time format options.
DatabaseUserLibraryList - A list of libraries to use with the request.
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Data Transfer ActiveX Automation Objects

DatabaseDownloadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various 
tasks:

Download - Run the configured download
DownloadAsync - Runs the configured download asynchronously
LoadRequest - Used to load a stored download request
SaveRequest - Used to save the current request
Cancel - Cancels a running Async request
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Data Transfer ActiveX Automation Objects

A simple Visual Basic program to run a download using the low level 
DatabaseDownloadRequest object:

Dim dlr As New cwbx.DatabaseDownloadRequest
Dim myiSeries As New cwbx.AS400System
myiSeries.Define "mysystem"
myiSeries.UserID = "myUserID"
myiSeries.Password = "myPassword"
Set dlr.System = myiSeries
dlr.AS400File = "qiws/qcustcdt"
dlr.pcFile = "c:\myfile"
dlr.pcFile.FileType = cwbdtBIFF8
dlr.Download
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Data Transfer ActiveX Automation Objects

Using the DatabaseUploadRequest Object

The DatabaseUploadRequest object can be used to programmatically perform an 
upload to the System i5 from a PC workstation.  It contains 3 additional objects that 
may be set to perform an upload:

DatabaseAS400File - Stores the name of the file or files to download.
DatabaseUploadPCFile - Stores the name of the PC file to upload, plus file 
options.
DatabaseUserLibraryList - A list of libraries to use with the request.
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Data Transfer ActiveX Automation Objects

DatabaseUploadRequest Object Methods

The DatabaseDownloadRequest object has several methods to perform various tasks:
Upload - Run the configured upload
UploadAsync - Runs the configured upload asynchronously
LoadRequest - Used to load a stored upload request
SaveRequest - Used to save the current upload request
Cancel - Cancels a running Async request
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Asynchronous Methods

The DatabaseDownloadRequest and DatabaseUploadRequest objects have 
asynchronous capabilities.  This means the upload or download request can run "In 
the background" while program execution continues.  A running Async request may 
also be cancelled by the main program.

The UploadAsync and DownloadAsync methods also pass events back to the 
running program.  These events are:

StatusChanged - Indicates that something has changed, like the request has 
completed, or there was an error, or a specific number of rows has been 
transferred.
UploadComplete - Indicates that an upload completed
DownloadComplete - Indicates that a download completed

Data Transfer ActiveX Automation Objects
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More information

Additional Information on the iSeries Access for Windows ActiveX automation objects can 
be found in the iSeries Access for Windows Toolkit.

This information can be found under the ActiveX section of the Database portion of the 
Toolkit documentation.
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Sample Code Disclaimer

This material contains IBM copyrighted sample programming source code for your 
consideration.  This sample code has not been thoroughly tested under all conditions.  
IBM, therefore, cannot guarantee or imply reliability, serviceability, or function.  IBM 
provides no program services for this material. This material is provided "AS IS" 
WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR IMPLIED, INCLUDING, 
BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF FITNESS FOR A 
PARTICULAR PURPOSE, OR NON-INFRINGEMENT.  SOME JURISDICTIONS DO 
NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THE ABOVE 
EXCLUSIONS MAY NOT APPLY TO YOU.  IN NO EVENT WILL IBM BE LIABLE TO 
ANY PARTY FOR ANY DIRECT, INDIRECT, SPECIAL OR OTHER CONSEQUENTIAL 
DAMAGES FOR ANY USE OF THIS MATERIAL INCLUDING, WITHOUT LIMITATION, 
ANY LOST PROFITS, BUSINESS INTERRUPTION, LOSS OF PROGRAMS OR 
OTHER DATA ON YOUR INFORMATION HANDLING SYSTEM OR OTHERWISE, 
EVEN IF EXPRESSLY ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.
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